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Chapter 705

Logrank Tests
(Lachin and Foulkes)
Introduction
This module computes the sample size and power of the logrank test for equality (or non-inferiority) of survival
distributions under the assumption of proportional hazards. Accrual time and follow-up time are included among
the parameters to be set.
A clinical trial is often employed to test the equality of survival distributions for two treatment groups. For
example, a researcher might wish to determine if Beta-Blocker A enhances the survival of newly diagnosed
myocardial infarction patients over that of the standard Beta-Blocker B. The question being considered is whether
the pattern of survival is different.
The two-sample t-test is not appropriate for two reasons. First, the data consist of the length of survival (time to
failure), which is often highly skewed, so the usual normality assumption cannot be validated. Second, since the
purpose of the treatment is to increase survival time, it is likely (and desirable) that some of the individuals in the
study will survive longer than the planned duration of the study. The survival times of these individuals are then
said to be censored. These times provide valuable information, but they are not the actual survival times. Hence,
special methods have to be employed which use both regular and censored survival times.
The logrank test is one of the most popular tests for comparing two survival distributions. It is easy to apply and is
usually more powerful than an analysis based simply on proportions. It compares survival across the whole
spectrum of time, not just at one or two points. This module allows the sample size and power of the logrank test
to be analyzed under very general conditions.
Power and sample size calculations for the logrank test have been studied by several authors. PASS uses the
methods of Lachin and Foulkes (1986) because of their generality. Although small differences among methods
can be found depending upon which assumptions are adopted, there is little practical difference between the
techniques.
The power calculations used here assume an underlying exponential distribution. However, this assumption is
rarely accurate in an actual clinical trial. How is this assumption justified? First, the logrank test and the test
derived using the exponential distribution have nearly the same power when the data are in fact exponentially
distributed. Second, under the proportional hazards model (which is assumed by the logrank test), the survival
distribution can be transformed to exponential and the logrank test remains the same under monotonic
transformations.

Technical Details
Some rather complicated formulas are used to define the input parameters. You need not understand the formulas.
However, you should understand the individual parameters used in these formulas.
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Basic Model
Suppose a clinical trial consists of two independent treatment groups labeled “1” and “2” (you could designate
group one as the control group and group two as the treatment group). If the total sample size is N, the sizes of the
two groups are n1 and n2 . Usually, you would plan to have n1 = n2 . Define the proportion of the total sample in
each group as

n
Q i = i , i = 1,2
N
Individuals are recruited during an accrual period of R years (or months or days). They are followed for an
additional period of time until a total of T years is reached. Hence, the follow-up period is T-R years. At the end of
the study, the logrank test is conducted at significance level α with power 1− β .
If we assume an exponential model with hazard rates λ1 and λ2 for the two groups, Lachin and Foulkes (1986,
Eq. 2.1) establish the following equation relating N and power:

 1
φ ( λ 1) φ ( λ 2 )
1
N |λ 1 - λ 2| = Z α φ (λ ) +  +Z β
+
Q1
Q2
 Q1 Q 2 
where

λ = Q1λ 1 + Q2λ 2

()

φ (λ ) = Nσ 2 λ
Zθ = Φ(1 − θ )

Φ( z ) is the area to the left of z under the standard normal density, λ is the maximum likelihood estimate of λ ,
and that σ 2 λ represents the variance of λ .

()

Exponential Distribution
The hazard rate from the exponential distribution, λ , is usually estimated using maximum likelihood techniques.
In the planning stages, you have to obtain an estimate of this parameter. To see how to accomplish this, let’s
briefly review the exponential distribution. The density function of the exponential is defined as

f(t) = λe − λt , t ≥ 0, λ > 0.
The cumulative survival distribution function is

S (t ) = e − λt , t ≥ 0.
Solving this for λ yields

λ = -

log( S (t ))
t

Note that S(t) gives the probability of surviving t years. To obtain a planning estimate of λ , you need only know
the proportion surviving during a particular time period. You can then use the above equation to calculate λ .
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Patient Entry
Patients are enrolled during the accrual period. PASS lets you specify the pattern in which subjects are enrolled.
Suppose patient entry times are distributed as g(t) where ti is the entry time of the ith individual and 0 ≤ ti ≤ R.
Let g(t)1 follow the truncated exponential distribution with parameter A, which has the density

 A e-At

, 0 ≤ t ≤ R, A ≠ 0
g(t ) = 1 - e- AR
1 / R,
0 ≤ t ≤ R, A = 0
Note that R is accrual time. The corresponding cumulative distribution function is

 1 − e − At

G(t ) = 1 − e − AR , 0 ≤ t ≤ R, A ≠ 0
t / R,
0 ≤ t ≤ R, A = 0
A is interpreted as follows.
A > 0 results in a convex (faster than expected) entry distribution.
A < 0 results in a concave (slower than expected) entry distribution.
A = 0 results in the uniform entry distribution in which g(t) =1/R.
Rather than specify A directly, PASS has you enter the percentage of the accrual time that will be needed to enroll
50% of the subjects. Using an iterative search, the value of A corresponding to this percentage is calculated and
used in the calculations.

Losses to Follow-Up
The staggered patient entry over the accrual period results in censoring times ranging from T - R to T years during
the follow-up period. This is often referred to as administrative censoring, since it is caused by the conclusion of
the study rather than by some random factor working on an individual. To model the losses to follow-up which
come from other causes, we use the exponential distribution with hazard rates η1 and η2 . Since these rates are
difficult and confusing to define directly, PASS lets you input the proportion lost due to other causes over a
specified period of time and uses the following equation to determine the hazard rates:

η = -

log(1 − P( t ))
t

General Model
Combining all these parameters into the model results in

 λ
λγ e- ( λ +η )T [1 - e( λ +η -γ )R] 
2
 .
φ( λ ,η ,γ ) = λ 
+
- γR
 λ + η (1 - e )(λ + η)(λ + η - γ ) 
-1

This expression may then be used in an equation that relates these parameters to sample size and power

 1
φ (λ 1) φ (λ 2)
1
+
N | λ 1 - λ 2| = Z α φ λ  +  + Z β
Q1
Q2
 Q1 Q 2 

()
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Proportion Surviving 1, Proportion Surviving 2, Accrual, Follow-Up, Alpha, Beta, and Sample Size.
Under most situations, you will select either Power or Sample Size.
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.
Select Power when you want to calculate the power.

Test
Alternative Hypothesis
This option specifies the alternative hypothesis in terms of the proportion surviving in each group. This implicitly
specifies the direction of the hypothesis test. The null hypothesis is always H 0 : S1 = S2 .

Note that the alternative hypothesis enters into power calculations by specifying the rejection region of the
hypothesis test. Its accuracy is critical.
Possible selections are:
•

Ha: S1 ≠ S2
This is the usual selection. It yields the two-tailed t-test. Use this option when you are testing whether the
survival curves are different, but you do not want to specify beforehand which curve is better.

•

Ha: S1 < S2
This option yields a one-tailed test. Use it when you are only interested in the case in which the survival in
group one is less than that for group two.

•

Ha: S1 > S2
This option yields a one-tailed test. Use it when you are only interested in the case in which the survival in
group one is greater than that for group two.
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Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal survival curves when in fact the curves are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when you
reject the null hypothesis of equal survival curves when in fact the curves are equal.
Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means
that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that
represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size – Total Sample Size
N (Total Sample Size)
This is the combined sample size of both groups. This amount is divided between the two groups using the value
of the Proportion in Group 1.

Sample Size – Sample Proportion
Proportion in Group 1
This is the proportion of N in group one. If this value is labeled p1 , the sample size of group one is Np1 and the
sample size of group two is N − Np1 . Note that the value of Np1 is rounded to the nearest integer.

Sample Size – Proportions Lost to Follow-Up
Group 1 and Group 2
This is the proportion in this group that is lost to follow-up during the Fixed Time Period, T0. Using this value,
the lost-to-follow-up hazard rate is calculated using the exponential distribution as it is with S(t). The equation
used to convert these proportions into η1 and η2 is:

ηi = -

log(1 − Pi (T0))
T0

Here P(T0) is the proportion lost to follow up from the beginning of the study until T0. So if T0 is 3 years and
10% of the patients in group one are lost to follow-up

η1 = − log(10
. − 01
. )/3
= 0.03512
Values between zero and one are valid. Zero is used to indicate no loss to follow-up.
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Effect Size
S1 and S2 (Proportion Surviving Past T0)
Specify the proportion of patients in each group that survive until after T0. These quantities are called S1 and S2.
The value of T0 is given in the Fixed Time Point box. For example, if the Fixed Time parameter is 3 and this
value is set to 0.7, then 70% of the patients survive at least 3 years. Note that since this is a proportion, values
must be between zero and one.
These quantities are used as a convenient method of entering the hazard rates λ1 and λ2 . The first group is
arbitrarily designated as the control group and the second group is arbitrarily designated as the treatment group.
The hazard rates are calculated from the proportions surviving using the formulas

λ1 = -

log( S1)
log( S 2)
and λ2 = T0
T0

If your sample size problem is cast in terms of hazard rates, the proportions surviving are calculated using the
formula

S1 = exp( − λ1t ) and S 2 = exp( − λ2t )
T0 (Fixed Time Point)
This is the time period used to convert the proportions given in Proportion Surviving 1, Proportion Surviving 2,
Follow-Up Loss1, and Follow-Up Loss2 into hazard rates. If you enter 0.4 in Proportion Survive1 and a 3 here,
you are indicating that 40% survive longer than 3 years.

Duration
R (Accrual Time)
The accrual time is the length of time during which patients enter the study. It is the value of R.
% Time Until 50% Accrual
This specifies the percentage of the accrual time needed to enroll 50% of the patients. This value is converted into
a value for A, the patient entry parameter. Use this option to indicate how subjects are enrolled during the accrual
period. For example, in one study, it may be possible to enroll a number of patients early on, while in another
study, most of the subjects will be enrolled near the end of the accrual period.
Values between 1 and 97 may be entered.
If you expect uniform patient entry, enter 50. Unless you know that patient enrollment will not be uniform during
the accrual period, you should use this amount.
If you expect more patients to enter during the early part of the accrual period, enter an amount less than 50 such
as 30. A 30 here means that 50% of the patients will have been enrolled when 30% of the accrual time has
elapsed.
If you expect more patients to enter during the later part of the accrual period, enter an amount greater than 50
such as 70. A 70 here means that 50% of the patients will have been enrolled when 70% of the accrual time has
elapsed.
PASS assumes that patient entry times follow the truncated exponential distribution. This parameter controls the
shape and scale of that distribution.
Follow-Up Time, T-R
The follow-up time is the length of time between the entry of the last individual into the study and the end of the
study. Since T is the total length of the study and R is the accrual time, the follow-up time is T-R.
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Example 1 – Finding the Power
A researcher is planning a clinical trial using a parallel, two-group, equal sample allocation design to compare the
survivability of a new treatment with that of the current treatment. The proportion surviving one-year after the
current treatment is 0.50. The new treatment will be adopted if the proportion surviving after one year increases to
0.75.
The trial will include a recruitment period of one-year after which participants will be followed for an additional
two-years. It is assumed that patients will enter the study uniformly over the accrual period. The researcher
estimates a loss-to-follow rate of 15% during the first year in both the control and the experimental groups.
The researcher decides to investigate various sample sizes between 10 and 250 at both the 0.01 and 0.05
significance levels.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Logrank Tests (Lachin and Foulkes) procedure window by expanding Survival, then clicking
on Legacy Procedures, and then clicking on Logrank Tests (Lachin and Foulkes). You may then make the
appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example
Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Ha: S1 ≠ S2
Alpha ....................................................... 0.01 0.05
N (Total Sample Size)............................. 10 25 50 100 150 200 250
Proportion in Group 1 ............................. 0.5
Proportion Lost to Follow-Up 1 ............... 0.15
Proportion Lost to Follow-Up 2 ............... 0.15
S1 (Proportion Surviving in Group 1) ...... 0.50
S2 (Proportion Surviving in Group 2) ...... 0.75
T0 (Fixed Time Point) ............................. 1
R (Accrual Time) ..................................... 1
% Time Until 50% Accrual ...................... 50
Follow-Up Time, T-R............................... 2

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results with Ha: S1 ≠ S2
Surviving
Power
N
Group 1
0.06718 10
0.50000
0.18406 10
0.50000
0.17527 25
0.50000
0.36633 25
0.50000
0.38357 50
0.50000
0.61606 50
0.50000
(report continues)

Surviving Accrual Follow Up
Group 2
Time
Time
0.75000
1.00
2.00
0.75000
1.00
2.00
0.75000
1.00
2.00
0.75000
1.00
2.00
0.75000
1.00
2.00
0.75000
1.00
2.00

Prop in
Group 1
0.50000
0.50000
0.50000
0.50000
0.50000
0.50000

Alpha
0.01000
0.05000
0.01000
0.05000
0.01000
0.05000

Beta
0.93282
0.81594
0.82473
0.63367
0.61643
0.38394
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Base Time: 1.00
Proportion loss to follow up in group 1 during the base time: 0.15000
Proportion loss to follow up in group 2 during the base time: 0.15000
Percent of accrual time until 50% enrollment is reached: 50.00%
Report Definitions
Power is the probability of rejecting a false null hypothesis. Power should be close to one.
Alpha is the probability of rejecting a true null hypothesis. It should be small.
Beta is the probability of accepting a false null hypothesis. It should be small.
Summary Statements
A two-sided log rank test with an overall sample size of 10 subjects (of which 5 are in group 1
and 5 are in group 2) achieves 7% power at a 0.01000 significance level to detect a difference
of 0.25000 between 0.50000 and 0.75000--the proportions surviving in groups 1 and 2 after 1.00
time periods. Patients entered the study during an accrual period of 2.00 time periods. 50% of
the enrollment was complete when 50.00% of the accrual time had past. A follow-up period of
1.00 time periods had a 15.0% loss from group 1 and a 15.0% loss from group 2.

This report shows the values of each of the parameters, one scenario per row. Note that approximately 100
patients, 50 per group, will be needed to achieve about 90% power at the 0.05 significance level.

Plots Section

This plot shows the relationship between sample size and power for the two significance levels.
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Example 2 – Finding the Sample Size
Continuing with the previous example, the researcher wants to investigate the sample size necessary to achieve
80% or 90% power for various values of the proportion surviving in the treatment group from 0.55 to 0.80 at the
0.05 significance level. All other parameters will remain the same.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Logrank Tests (Lachin and Foulkes) procedure window by expanding Survival, then clicking
on Legacy Procedures, and then clicking on Logrank Tests (Lachin and Foulkes). You may then make the
appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example
Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Ha: S1 ≠ S2
Power ...................................................... 0.80 0.90
Alpha ....................................................... 0.05
Proportion in Group 1 ............................. 0.5
Proportion Lost to Follow-Up 1 ............... 0.15
Proportion Lost to Follow-Up 2 ............... 0.15
S1 (Proportion Surviving in Group 1) ...... 0.5
S2 (Proportion Surviving in Group 2) ...... 0.55 to 0.80 by 0.05
T0 (Fixed Time Point) ............................. 1
R (Accrual Time) ..................................... 1
% Time Until 50% Accrual ...................... 50
Follow-Up Time, T-R............................... 2

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots
Numeric Results with Ha: S1 ≠ S2
Power
0.90004
0.80017
0.90024
0.80050
0.90001
0.80010
0.90098
0.80177
0.90107
0.80357
0.90274
0.80432

N
2798
2090
690
515
302
225
168
125
106
79
73
54

Surviving
Group 1
0.50000
0.50000
0.50000
0.50000
0.50000
0.50000
0.50000
0.50000
0.50000
0.50000
0.50000
0.50000

Surviving Accrual Follow Up
Group 2
Time
Time
0.55000
1.00
2.00
0.55000
1.00
2.00
0.60000
1.00
2.00
0.60000
1.00
2.00
0.65000
1.00
2.00
0.65000
1.00
2.00
0.70000
1.00
2.00
0.70000
1.00
2.00
0.75000
1.00
2.00
0.75000
1.00
2.00
0.80000
1.00
2.00
0.80000
1.00
2.00

Prop in
Group 1
0.50000
0.50000
0.50000
0.50000
0.50000
0.50000
0.50000
0.50000
0.50000
0.50000
0.50000
0.50000

Alpha
0.05000
0.05000
0.05000
0.05000
0.05000
0.05000
0.05000
0.05000
0.05000
0.05000
0.05000
0.05000

Beta
0.09996
0.19983
0.09976
0.19950
0.09999
0.19990
0.09902
0.19823
0.09893
0.19643
0.09726
0.19568
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Base Time: 1.00
Proportion loss to follow up in group 1 during the base time: 0.15000
Proportion loss to follow up in group 2 during the base time: 0.15000
Percent of accrual time until 50% enrollment is reached: 50.00%

This study shows the huge increase in sample size necessary to detect values of S2 below 0.65. It also shows that
roughly 35% more participants are required for 90% power than for 80% power in this situation.
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Example 3 – Validation using Lachin and Foulkes
Lachin and Foulkes (1986), the developers of formulas used in this routine, give an example on page 509 in which
λ1 = 0.30 , λ2 = 0.20 , N = 378 , α = 0.05 (one-sided), R = 3 , T = 3 , and β = 010
. . There is no loss to follow
up and uniform patient entry is assumed.
The first step is to determine the proportion surviving at the end of one year for each group using the formula:

S(t) = e − λt
For group 1 we have

S1 (1) = e −0.3(1)
= 0.74081822
For group 2 we have

S 2 (1) = e −0.2(1)
= 0.81873075

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Logrank Tests (Lachin and Foulkes) procedure window by expanding Survival, then clicking
on Legacy Procedures, and then clicking on Logrank Tests (Lachin and Foulkes). You may then make the
appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example
Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Ha: S1 < S2
Alpha ....................................................... 0.05
N (Total Sample Size)............................. 378
Proportion in Group 1 ............................. 0.5
Proportion Lost to Follow-Up 1 ............... 0.0
Proportion Lost to Follow-Up 2 ............... 0.0
S1 (Proportion Surviving in Group 1) ...... 0.74081822
S2 (Proportion Surviving in Group 2) ...... 0.81873075
T0 (Fixed Time Point) ............................. 1
R (Accrual Time) ..................................... 3
% Time Until 50% Accrual ...................... 50
Follow-Up Time, T-R............................... 2
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Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results with Ha: S1 < S2

Power
N
0.90123 378

Surviving
Group 1
0.74082

Surviving Accrual Follow Up
Group 2
Time
Time
0.81873
3.00
2.00

Prop in
Group 1
0.50000

Alpha
0.05000

Beta
0.09877

Base Time1.00
Proportion loss to follow up in group 1 during the base time: 0.00000
Proportion loss to follow up in group 2 during the base time: 0.00000
Percent of accrual time until 50% enrollment is reached: 50.00%

The power of 0.90 matches the value published in Lachin’s article.

Example 4 – Non-Inferiority Test
This example will show how to use this module to calculate power and sample size for non-inferiority trials.
Remember that non-inferiority is established by showing that the new treatment is no worse than the standard
treatment, except for a small amount called the margin of equivalence.
Consider the following example. Suppose the median survival time of the standard drug is 15 months.
Unfortunately, this drug has serious side effects. A promising new drug has been developed that has much milder
side effects. A non-inferiority trial is to be designed to show that the new drug is not inferior to the standard drug.
The margin of equivalence is set at 3 months, so, to establish non-inferiority, the study has to conclude that the
median survival time of the new drug is at least 12 months.
The trial will accept subjects for 18 months. It will continue for an additional 6 months after the accrual period.
Although the study planners anticipate some dropout, they want to begin their analysis without considering
dropout. They set the significance level at 0.05. They want to determine the necessary sample size to achieve 80%
and 90% power. The calculations proceed as follows.
Use the Survival Parameter Conversion Tool to convert the “median survival rates” to “proportions surviving” so
that they can be entered into the panel. Press the Survival Parameter Conversion Tool button that is next to the
S1 box to display this window. Enter 24 for T0, 12 for Median Survival Time 1 (T1), and 15 for Median
Survival Time 2 (T2). This results in values for S1 and S2 of 0.25 and 0.329876977693224, respectively.
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Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Logrank Tests (Lachin and Foulkes) procedure window by expanding Survival, then clicking
on Legacy Procedures, and then clicking on Logrank Tests (Lachin and Foulkes). You may then make the
appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open Example
Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Ha: S1 < S2
Power ...................................................... 0.80 0.90
Alpha ....................................................... 0.05
Proportion in Group 1 ............................. 0.5
Proportion Lost to Follow-Up 1 ............... 0.0
Proportion Lost to Follow-Up 2 ............... 0.0
S1 (Proportion Surviving in Group 1) ...... 0.25
S2 (Proportion Surviving in Group 2) ...... 0.329876977693224
T0 (Fixed Time Point) ............................. 24
R (Accrual Time) ..................................... 18
% Time Until 50% Accrual ...................... 50
Follow-Up Time, T-R............................... 6

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Power
0.90018
0.80030

N
1326
957

Surviving
Group 1
0.25000
0.25000

Surviving
Group 2
0.32988
0.32988

Accrual
Time
18.00
18.00

Follow Up
Time
6.00
6.00

Prop in
Group 1
0.50000
0.50000

Alpha
0.05000
0.05000

Beta
0.09982
0.19970

Thus, a sample size of about 663 per group would be needed for 90% power, and a sample of 479 per group
would be needed for 80% power.
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